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ُ يَـعْلَمُ وَأنَتُمْ لاَ تَـعْلَمُونَ   وَٱللهَّ

“Allah mengetahui, sedang kamu tidak mengetahui.” (QS. Al-Baqarah:216) 
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ABSTRAK 
 
Mazyadi, Muhammad. 2023. Simulasi Dinamika Molekuler Kompleks FGF2-FGFR1-

Heparin 8 dan 12 Sakarida dengan Pola Sulfasi 2S dan Konformasi Iduronat 
1C4 sebagai Antikanker. Skripsi. Program Studi Kimia Fakultas Sains dan 
Teknologi Universitas Islam Negeri Maulana Malik Ibrahim Malang. 
Pembimbing I: Himmatul Barroroh, M.Si; Pembimbing II: Lilik Miftahul 
Khoiroh, M.Si 

Kata Kunci: Antikanker, Heparin, Penambatan Molekul, Dinamika Molekuler. 
 

Heparin merupakan polimer linear yang terdiri dari unit berulang 1-4 asam iduronat 
dan glukosamin. Heparin dikenal potensinya sebagai obat antikanker karena 
kemampuannya dalam mengurangi pertumbuhan sel kanker. Heparin melakukan fungsinya 
dengan memediasi persinyalan FGF dan FGFR. Tujuan dari penelitian ini adalah untuk 
mengetahui perubahan struktur 3D dan stabilitas kompleks FGF2-FGFR1-Heparin 8 dan 
12 sakarida. Metode yang digunakan dalam mempelajari stabilitas heparin sebagai kandidat 
obat antikanker dalam penelitian ini adalah penambatan molekul dan simulasi dinamika 
molekul. Ligan uji yang digunakan adalah heparin 8 dan 12 sakarida 2S konformasi 1C4. 
Penambatan ligan uji dengan protein FGFR1-FGF2 mengacu pada parameter ikatan yang 
dihasilkan dan visualisasi terhadap protein target. Hasil penambatan molekul divalidasi dan 
disimulasikan dinamika molekulnya menggunakan Gromacs berdasarkan parameter nilai 
RMSD dan RMSF. Ligan heparin 12 sakarida 2S memiliki kemampuan yang lebih baik 
daripada heparin 8 sakarida 2S dalam mempertahankan ikatan dan struktur kompleks 
dengan FGFR1-FGF2 hingga akhir simulasi. Hal ini menunjukkan ligan heparin 12 
sakarida 2S dapat menjadi kandidat sebagai antikanker. 
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ABSTRACT 
 
Mazyadi, Muhammad. 2023. Simulation of Complex Molecular Dynamics of FGF2-

FGFR1-Heparin 8 and 12 Saccharides with 2S Sulfation Patterns and 1C4 
Iduronat Conformation as Anticancer. Thesis. Department of Chemistry, 
Faculty of Science and Technology, State Islamic University of Maulana Malik 
Ibrahim Malang. Supervisor I: Himmatul Barroroh, M.Si; Supervisor II: Lilik 
Miftahul Khoiroh, M.Si 

Keyword: Anticancer, Heparin, Molecular Docking, Molecular dynamic. 
 

Heparin is a linear polymer composed of repeating units 1–4 of iduronic acid and 
glucosamine. Heparin is known for its potential as an anticancer drug due to its ability to 
reduce cancer cell growth. Heparin performs its function by mediating FGF and FGFR 
signaling. The purpose of this study was to determine the changes in 3D structure and 
stability of FGF2-FGFR1-Heparin 8 and 12 saccharide complexes. The methods used in 
studying the stability of heparin as an anticancer drug candidate in this study are molecular 
tethering and molecular dynamics simulation. The test ligands used were heparin 8 and 12 
saccharides in 2S conformation 1C4. The tethering of the test ligands with FGFR1-FGF2 
proteins refers to the resulting binding parameters and visualization of the target proteins. 
The molecular tethering results were validated and simulated using Gromacs based on 
RMSD and RMSF value parameters. The heparin 12 saccharide 2S ligand has a better 
ability than the heparin 8 saccharide 2S ligand to maintain the bond and complex structure 
with FGFR1-FGF2 until the end of the simulation. This suggests the heparin-12 saccharide 
2S ligand can be a candidate as an anticancer agent.  
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 مستخلص البحث
 

الديناميات الجزيئية  2023مزيد ، محمد.    مع نمط الكبريت  ١٢و   ٨ للسكر�تHeparin-FGFR1-FGF2 . محاكاة 
S24  ايدورو�ت  وتشكيلC1 البحث الجامعي. قسم الكيمياء، كلية العلوم والتكنولوجيا بجامعة مولا�   .كمضاد للسرطان

 . ليليك مفتاح الخيرة، الماجستيرة: ٢. المشرفة الماجستيرةهمة البررة، : ١مالك إبراهيم الإسلامية الحكومية مالانج. المشرفة 
 

 .الديناميات الجزيئيةالإلتحام الجزيئي،  ,الهيبارين ,مضاد للسرطان : الكلمات المفتاحية

بإمكانياته  وحدات متكررة من حمض الأيدورونيك والجلوكوزامين. يعُرف الهيبارين    4-1الهيبارين هو بوليمر خطي يتكون من  
و    FGFمضاد للسرطان بسبب قدرته على الحد من نمو الخلا� السرطانية. سيقوم الهيبارين بأداء وظيفته بوساطة إشارات  كدواء  

FGFR  الدراسة هذه  من  الغرض  مجمعات. كان  وثبات  الأبعاد  ثلاثية  البنية  في  التغيير  تحديد  -FGF2-FGFR1هو 
Heparin    8   كانت الطرق المستخدمة في دراسة ثبات الهيبارين كعقار مرشح مضاد للسرطان في هذه الدراسة السكر�ت.    12و

في التشكل    2S  12و    8هي سكر�ت الهيبارين    . كانت روابط الاختبار المستخدمةهي الالتحام الجزيئي ومحاكاة الديناميكيات الجزيئية
4C1  يشير ارتباط يجند الاختبار مع بروتين .FGF2-FGFR1    إلى معلم الربط الناتجة وتصور البروتين المستهدف. تم التحقق من

. RMSFو    RMSDبناءً على قيم معلم    Gromacsصحة نتائج الالتحام الجزيئي ومحاكاة الديناميات الجزيئية باستخدام  
في الحفاظ على الروابط والهياكل المعقدة    2S السكر�ت 8بقدرة أفضل من الهيبارين   2Sالسكر�ت Heparin 12 يتمتع يجند 
يمكن أن يكون مرشحًا   2S  تسكر�  12حتى �اية المحاكاة. هذا يدل على أن ليجند الهيبارين    FGFR1-FGF2باستخدام  

كمضاد للسرطان.
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BAB I 

PENDAHULUAN 

 

1.1 Latar Belakang 

Kanker adalah penyakit penyebab utama kematian kedua di dunia setelah 

penyakit kardiovaskular dan diproyeksikan untuk memulai penyebab utama 

kematian dalam beberapa tahun mendatang. Data Global Cancer Observatory 

tahun 2018 menunjukkan angka kejadian penyakit kanker di Indonesia 

(136,2/100.000 penduduk) berada pada urutan 8 di Asia Tenggara, sedangkan di 

Asia urutan ke 23 (Kemenkes RI, 2019).  

Heparin telah dikenal luas sebagai polisakarida yang berfungsi sebagai obat 

antikoagulan. Heparin pertama kali ditemukan oleh JayMcLean pada tahun 1916 

yang diisolasi dari hati anjing. Saat ini, secara umum heparin diperoleh dari ekstrak 

paru sapi atau mucosa usus babi. (Mulyadi, 2007). Pengobatan menggunakan 

heparin dapat menurunkan angka kematian dan kesakitan akibat penyakit trombosis 

akut. Prosedur uji klinis oleh Crafoord dan Best pada tahun 1935 mampu 

membuktikan efektivitas dari heparin sebagai antikoagulan, sehingga 

penggunaannya secara medis dilanjutkan hingga sekarang. (Capila, 2002).  

Heparin merupakan polisakarida linier yang dicirikan oleh unit disakarida 

berulang dari 12 kemungkinan residu glukosamin tersubstitusi N (GlcN) dan satu 

dari 4 residu asam heksuronat yang terdiri dari asam glukoronat (GlcA) atau asam 

iduronate (IdoA). Selama biosintesis terjadi modifikasi pada rantai heparin, yakni 

sulfasi pada posisi C-2 O dari asam iduronat (2S) dan sulfasi posisi N, C-6 dan C-

3 O dari glukosamin (2SNS). Residu 2-O-asam iduronat tersulfasi (IdoA2S) 
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memiliki 3 macam konformasi yakni 4C1, 1C4, dan 2S0. Konformasi Iduronat 2S0 

memiliki interaksi N-sulfat glukosamin dengan FGF dengan energi yang besar, 

sedangkan konformasi 4C1 dan 1C4 hanya mengikat reseptor sementara. (Guerrini, 

2007). Penelitian yang dilakukan Cole, dkk. (2010) bahwa ligan heparin 

oligosakarida  memiliki 7-12 residu sakarida 2-O-sulfat iduronat (2S) atau 2-O-

sulfat iduronat dan glukosamina N-sulfat (2SNS). Kemampuan oligosakarida 

dalam mengikat FGF2 meningkat secara signifikan dengan panjang oligosakarida 

dan sulfasi. Hal ini juga sejalan dengan potensi penghambatan oligosakarida 

terhadap respon sel endotel yang diinduksi FGF2. Pada oligosakarida 8 sakarida 2S 

tidak ditemukan pengaruh terhadap sel endotel. Sedangkan pada heparin 12 

sakarida 2S terdapat pengurangan sebesar 75% dalam menghambat pengikatan 

FGF2 terhadap heparin. 

Berdasarkan strukturnya heparin dibagi menjadi unfractioned heparin (UFH) 

dan low molecular weight heparin (LMWH). UFH memiliki aktivitas biologis 

bervariasi dikarenakan rantai polisakaridanya yang heterogen (Atallah, dkk., 2020). 

Rantai UFH dapat menyebabkan efek samping bagi metabolisme tubuh ketika 

berikatan dengan protein. Oleh sebab itu, dikembangkan LMWH yang merupakan 

kelompok senyawa turunan dari UFH (Oduah, dkk., 2016). LWMH menunjukkan 

sifat antitrombotik yang lebih besar dengan sedikit sifat antikoagulan dan 

komplikasi pendarahan daripada UFH. Hal ini dapat meningkatkan efikasi obat 

(Kakkar, 2004). 

Penggunaan heparin dalam mengobati kanker telah lama diteliti karena 

kemampuannya untuk melemahkan kerusakan yang disebabkan oleh berbagai 

kanker, terutama dalam hal metastasis (Alyahya, dkk., 2015). Sifat anti kanker 
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heparin berkaitan dengan pelepasan penghambat koagulasi Tissue Factor Pathway 

Inhibitor (TFPI) dari endotel vascular yang menghambat persinyalan TF. 

Persinyalan TF akan menghambat faktor x untuk berubah menjadi faktor xa, 

sehingga pembentukan trombin tidak dapat terjadi. Trombin dapat menghentikan 

aktivitas fibrinogen menjadi helai-helai fibrin yang berdampak pada perkembangan 

tumor (Mousa dan Petersen, 2009). Heparin untuk melakukan fungsinya akan 

dimediasi oleh persinyalan fibroblast growth factor (FGF) dan fibroblast growth 

factor receptor (FGFR), dimana persinyalan mempengaruhi perkembangan kanker 

melalui empat kelompok yaitu, perubahan genom FGFR malalui tiga mekanisme, 

pembentukan lingkaran parakrin, pembentukan lingkaran autokrin, dan efek stroma 

FGF (Turner dan Grose, 2010). 

Heparin yang ditemukan ditubuh makhluk hidup memiliki kemampuan dalam 

mengurangi pertumbuhan sel kanker. Namun, masih perlu dilakukan berbagai 

penelitian lebih lanjut untuk memaksimalkan kerja heparin sebagai antikanker. Hal 

tersebut mendorong perlunya usaha menemukan heparin yang lebih spesifik dan 

lebih stabil. Allah SWT menciptakan semua yang ada di bumi ini tidaklah sia-sia. 

Semua yang telah diciptakan oleh Allah SWT dapat dimanfaatkan oleh manusia 

jika manusia itu dapat berfikir. Sebagaimana yang telah dijelaskan di dalam al-

Qur’an surat al-Jatsiyah, ayat 13 : 

 

یٰتٍ لِّقوَْمٍ یَّتفَكََّرُ  نْھُ اۗنَِّ فِيْ ذٰلِكَ لاَٰ ا فىِ السَّمٰوٰتِ وَمَا فِى الاْرَْضِ جَمِیْعاً مِّ رَ لَكُمْ مَّ   وْنَ وَسَخَّ

 
Artinya : “Dan Dia telah menundukkan untukmu apa yang di langit dan apa yang 

di bumi semuanya, (sebagai rahmat) daripada-Nya. Sesungguhnya pada 
yang demikian itu benar-benar terdapat tanda-tanda (kekuasaan Allah) 
bagi kaum yang berfikir.” (Q.S.al-Jatsiyah :13) 
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Ayat tersebut menjelaskan bahwa Allah menundukkan semua makhluk 

ciptaan Nya yang ada di langit dan di bumi agar manusia dapat menggunakan dan 

memanfaatkannya untuk kepentingan mereka dalam melaksanakan tugas sebagai 

khalifah Allah di bumi. Hal ini berarti bahwa manusia wajib berusaha mencari 

manfaat dan kegunaan ciptaan Allah bagi mereka. Kunci dari semuanya adalah 

kemauan berusaha dan keinginan mengetahui sebagian pengetahuan Allah. Semua 

ini untuk kepentingan hidup dan kehidupan manusia. Namun, baru sebagian kecil 

saja dari ilmu Allah yang telah diketahui manusia. Berdasarkan ayat tersebut 

menjelaskan pula bahwa penggunaan heparin sebagai obat merupakan bentuk 

upaya berpikir manusia untuk memanfaatkan ciptaan-Nya menjadi sesuatu yang 

bermanfaat, salah satunya sebagai antikanker. 

Beberapa tahun terakhir, teknologi microarray dan bioinformatika telah 

diterapkan secara luas untuk mempelajari mekanisme perkembangan tumor dan 

telah terbukti menjadi alat yang bermanfaat untuk mengidentifikasi biomarker 

diagnostik dan prognostik baru untuk banyak jenis kanker (Qin, dkk., 2021). 

Penelitian sebelumnya yang dilakukan oleh Harir (2022) pada senyawa heparin 2S 

dan 2SNS 2-12 sakarida konformasi iduronat 4C1 pada kompleks protein FGF2-

FGFR1 sebagai antikanker menggunakan metode docking diketahui bahwa 

interaksi untuk molekul docking tergantung pada sulfasi dan panjang heparin. 

Interaksi yang terbentuk yaitu ikatan hidrogen, interaksi elektrostatik, jembatan 

garam, ikatan hidrofobik, dan ikatan pi. 

Metode penambatan molekul (docking) memberikan fleksibilitas tinggi untuk 

ligan, sementara protein disimpan kurang lebih tetap atau disediakan dengan 

fleksibilitas terbatas untuk residu yang ada di dalam atau di dekat situs aktif. Hal 
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ini meningkatkan kompleksitas ruang dan waktu komputasi secara eksponensial. 

Namun, merancang inhibitor struktur tunggal yang kaku atau molekul obat dapat 

menyebabkan hasil yang salah. Karena terdapat kekurangan pada metode docking, 

maka pada penelitian ini digunakan metode dinamika molekular sebagai alat pasca 

pemrosesan untuk memvalidasi dan/atau menyempurnakan solusi docking.  

Dinamika molekular adalah teknik simulasi komputer yang mengamati 

pergerakan molekul-molekul yang saling berinteraksi satu sama lain. Pada 

dinamika molekuler, besar gaya antar molekul dihitung secara eksplisit dan 

pergerakan molekul dikomputasi dengan metode integrasi. Metode ini digunakan 

untuk menyelesaikan persamaan newton pada atom yang konstituen, dimana 

kondisi awal digambarkan dengan posisi dan kecepatan atom. Berdasarkan persepsi 

newton, dari posisi awal, dapat dilakukan penghitung posisi dan kecepatan 

selanjutnya dalam interval waktu yang kecil serta penghitungan gaya pada posisi 

yang baru. Hal ini berulang untuk beberapa saat, bahkan hingga ratusan kali (Astuti 

dan Mutiara, 2011).  

Gromacs merupakan salah satu software yang dapat menampilkan model 

dinamis dari model statis melalui simulasi dinamika molekul (Makarewicz dan 

Kaźmierkiewicz, 2013). Berdasarkan penelitian Van der Spoel (2005) Gromacs 

merupakan  software dinamika molekul yang cepat dan juga kompatibel dengan 

berbagai force field. Pendekatan yang digunakan dalan aplikasi Gromacs berupa 

pendekatan persamaan hukum newton dan mekanika klasik (Astuti dan Mutiara, 

2011).  

Hasil simulasi berupa file trajectory kemudian dianalisis menggunakan 

software Gromacs untuk mengetahui nilai Root Mean Square Deviation (RMSD) 
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dan Root Mean Square Fluctuation (RMSF). RMSD merupakan parameter 

kemiripan berdasarkan perbandingan perubahan jarak dan konformasi ligan terbaik 

hasil simulasi dengan jarak dan konformasi ligan awal sebelum simulasi 

(Puratchikody, dkk., 2016). Nilai RMSD berfungsi mengamati perubahan struktur 

kompleks yang terjadi selama simulasi. Sedangkan RMSF merupakan fluktuasi 

setiap atom tunggal berdasarkan rata-rata posisinya selama simulasi (Shahraki, dkk., 

2018). Nilai RMSF berfungsi mengidentifikasi bagian fleksibel dalam molekul, 

nilai RMSF rendah dianggap memiliki kestabilan yang lebih baik (Fakih, dkk., 

2020). Kedua nilai tersebut akan memberikan informasi bagaimana interaksi obat 

heparin sebagai kandidat antikanker mengubah perilaku residu asam amino protein 

FGFR1-FGF2.  

Pada penelitian Harir (2022) pengujian heparin 8 sakarida 2S konformasi 4C1 

menggunakan metode docking diperoleh nilai RMSD sebesar 1,869 Å. Sedangkan 

pada heparin 12 sakarida 2S konformasi 4C1 menggunakan metode docking 

diperoleh nilai RMSD sebesar 2,262 Å. Hal ini membuktikan bahwa heparin 8 dan 

12 sakarida 2S konformasi 4C1 hasil docking dianggap tidak berbeda jauh dengan 

heparin di alam dan memiliki sifat biologis yang sama.   

Oleh karena itu dalam penelitian ini akan dilakukan simulasi dinamika 

molekul kompleks FGF2-FGFR1-Heparin 8 dan 12 sakarida dengan pola sulfasi 2S 

dan konformasi asamiduronat 1C4 sebagai antikanker. 

1.2 Rumusan Masalah 

Adapun rumusan masalah dalam penelitian ini adalah: 

a. Bagaimana perubahan struktur 3D kompleks FGF2-FGFR1-Heparin 8 dan 12 

sakarida 2S konformasi 1C4 selama waktu simulasi dinamika molekuler? 
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b. Bagaimana stabilitas interaksi kompleks FGF2-FGFR1-Heparin 8 dan 12 

sakarida 2S konformasi 1C4 ditinjau dari interaksinya selama waktu simulasi 

dinamika molekuler sebagai antikanker? 

 

1.3 Tujuan 

Adapun tujuan dalam penelitian ini adalah: 

a. Mengetahui perubahan struktur 3D kompleks FGF2-FGFR1-Heparin 8 dan 

12 sakarida 2S konformasi 1C4 selama waktu simulasi dinamika molekuler? 

b. Mengetahui stabilitas interaksi kompleks FGF2-FGFR1 Heparin 8 dan 12 

sakarida 2S konformasi 1C4 ditinjau dari parameter energi interaksinya 

selama waktu simulasi dinamika molekuler sebagai antikanker? 

 

1.4 Batasan Masalah 

Adapun batasan masalah dalam penelitian ini adalah: 

a. Sampel berasal dari PDB (Protein Data Bank). 

b. Heparin 8 dan 12 sakarida 2S dengan konformasi 1C4.  

c. Metode yang digunakan adalah penambatan molekul dan simulasi dinamika 

molekul dengan running 100 ns. 

d. Menggunakan perangkat lunak Gromacs, Grace, PyMol, Discovery Studio, 

UCSF Chimera, dan VMD. 

1.5 Manfaat Penelitian 

Manfaat dari penelitian ini adalah memberikan pengetahuan mengenai 

heparin untuk obat antikanker dan berkontribusi dalam pengembangan ilmu sains, 

agama, dan bidang kimia. 
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BAB II 

TINJAUAN PUSTAKA 

 

2.1 Kanker 

Kanker adalah sekelompok penyakit yang ditandai dengan pertumbuhan dan 

penyebaran sel abnormal yang tidak terkendali. Jika penyebaran sel kanker atau 

metastasis tidak terkontrol, dapat mengakibatkan kematian (Mathur, dkk., 2015). 

Kanker dapat terjadi akibat proliferasi abnormal dari berbagai jenis sel di dalam 

tubuh, sehingga ada lebih dari seratus jenis kanker berbeda, yang dapat bervariasi 

dalam perilaku dan responsnya terhadap pengobatan. Isu yang paling penting dalam 

patologi kanker adalah perbedaan antara tumor jinak dan ganas. Tumor jinak, 

seperti kutil kulit biasa, tetap terbatas pada lokasi aslinya dan tidak menyerang 

jaringan normal di sekitarnya atau menyebar ke bagian tubuh lain. Namun, tumor 

ganas mampu menyerang jaringan normal di sekitarnya dan menyebar ke seluruh 

tubuh melalui sistem peredaran darah atau limfatik (metastasis). Hanya tumor ganas 

yang secara tepat disebut sebagai kanker. Kemampuan mereka untuk menyerang 

dan bermetastasis yang membuat kanker begitu berbahaya (Cooper GM, 2000). 

Kanker disebabkan oleh banyak faktor eksternal (tembakau, bahan kimia, 

radiasi, dan organisme menular) serta beberapa faktor internal (mutasi bawaan, 

hormon, kondisi kekebalan, dan mutasi gen acak). Penyebab kanker beragam, 

kompleks dan hanya sebagian yang dipahami. Banyak hal yang diketahui dapat 

meningkatkan risiko kanker, termasuk diet, infeksi tertentu, kurangnya aktivitas 

fisik, obesitas, dan polusi lingkungan. Faktor-faktor ini dapat bertindak bersama 
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sama untuk memulai karsinogenesis dalam tubuh manusia dan menjadi penyebab 

utama kematian (Mathur, dkk., 2015). 

Pada tingkat sel, perkembangan kanker dipandang sebagai proses 

multilangkah yang melibatkan mutasi dan seleksi sel dengan kapasitas yang 

semakin meningkat untuk proliferasi, kelangsungan hidup, invasi, dan metastasis. 

Langkah pertama dalam proses ini, inisiasi tumor, dianggap sebagai hasil dari 

perubahan genetik yang menyebabkan proliferasi abnormal dari satu sel. Proliferasi 

sel kemudian mengarah pada pertumbuhan populasi sel tumor yang diturunkan 

secara klonal. Perkembangan tumor berlanjut ketika mutasi tambahan terjadi di 

dalam sel-sel tumor. Beberapa dari mutasi ini memberikan keuntungan selektif pada 

sel, seperti pertumbuhan yang lebih cepat. Proses ini disebut seleksi klon, karena 

klon baru sel tumor telah berevolusi berdasarkan peningkatan laju pertumbuhannya 

atau sifat lain (seperti kelangsungan hidup, invasi, atau metastasis) yang 

memberikan keuntungan selektif. Seleksi klon berlanjut sepanjang perkembangan 

tumor, sehingga tumor terus tumbuh lebih cepat dan semakin ganas (Cooper GM, 

2000). 

Pengobatan penyakit kanker telah dikembangkan berbagai macam 

pengobatan dari terapi farmakologi, radioterapi, kemoterapi, hormonterapi, 

immunoterapi, bahkan tindakan pembedahan dengan resiko yang timbul sehingga 

pasien penderita kanker memerlukan pendekatan sistemik pada pengobatan 

penyakit tersebut. Kemoterapi dilakukan untuk membunuh sel kanker dengan obat 

anti kanker (Setiawan, 2015). Tujuan kemoterapi adalah untuk menghambat 

proliferasi sel dan multiplikasi tumor, sehingga menghindari invasi dan metastasis. 

Meskipun kemoterapi adalah pendekatan terapi yang penting untuk kanker, 



10 

 

keberhasilannya sangat terbatas karena kurangnya selektivitas, yang menyebabkan 

eliminasi sel tumor dan toksisitas sistemik yang tidak memadai. Oleh karena itu, 

terapi bertarget molekuler mendapatkan banyak daya tarik karena kekhususannya 

terhadap sel kanker dengan menyelamatkan sel normal. Pada dasarnya, terapi 

bertarget molekuler melibatkan pengembangan obat yang memblokir ciri khas 

kanker. Oleh karena itu, identifikasi target molekuler merupakan dorongan utama 

untuk terapi kanker bertarget melalui teknologi dan pendekatan baru (Hou, dkk., 

2022). Hal ini sesuai dengan hadist yang diriwayatkan oleh Imam Abul Husain 

Muslim yang berbunyi: 

 

ثَـنَا هَارُونُ بْنُ  ثَـنَا ابْنُ وَهْبٍ أَخْبرََنيِ عَمْرٌو وَهُوَ ابْنُ الحْاَرِ حَدَّ  ثِ عَنْ مَعْرُوفٍ وَأبَوُ الطَّاهِرِ وَأَحمَْدُ بْنُ عِيسَى قاَلُوا حَدَّ
ُ عَلَيْهِ  وَسَلَّمَ أنََّهُ قاَلَ لِكُلِّ دَاءٍ دَوَاءٌ فإَِذَا أُصِيبَ  عَبْدِ رَبِّهِ بْنِ سَعِيدٍ عَنْ أَبيِ الزُّبَيرِْ عَنْ جَابِرٍ عَنْ رَسُولِ اللهَِّ صَلَّى اللهَّ

اءِ بَـرَأَ بإِِذْنِ اللهَِّ عَزَّ وَجَلَّ   دَوَاءُ الدَّ
Artinya: “Telah menceritakan kepada kami Harun bin Ma'ruf dan Abu Ath Thahir 

serta Ahmad bin 'Isa mereka berkata; Telah menceritakan kepada kami 
Ibnu Wahb; Telah mengabarkan kepadaku 'Amru, yaitu Ibnu al-Harits 
dari 'Abdu Rabbih bin Sa'id dari Abu Az Zubair dari Jabir dari Rasulullah 
shallallahu 'alaihi wasallam, beliau bersabda: "Setiap penyakit ada 
obatnya. Apabila ditemukan obat yang tepat untuk suatu penyakit, akan 
sembuhlah penyakit itu dengan izin Allah 'azza wajalla." (HR Muslim).  

 

Maksud hadist tersebut adalah semua penyakit yang menimpa manusia 

melainkan sudah tersedia obatnya, hanya Allah tidak menyingkapkannya secara 

terang-terangan. Hikmahnya adalah manusia harus berusaha secara maksimal 

dalam setiap usahanya (Dirhamzah, dkk., 2020). Pengembangan heparin sebagai 

obat antikanker merupakan salah satu usaha manusia dalam menghadapi penyakit 

kanker.  
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Mekanisme seluler yang mendorong atau menekan proliferasi dan 

diferensiasi sel sangat rumit, melibatkan beberapa gen, reseptor, dan transduksi 

sinyal. Investigasi dalam biologi sel kanker telah menghasilkan wawasan yang 

signifikan tentang mekanisme apoptosis, angiogenesis, metastasis, transduksi 

sinyal sel, diferensiasi, dan modulasi faktor pertumbuhan. Para peneliti sedang 

merancang terapi bertarget molekuler pada jalur ini, secara selektif menghambat 

pertumbuhan, misalnya dengan menargetkan pensinyalan sel atau angiogenesis dan 

memblokir degradasi protein (Amjad, dkk., 2022). 

 

2.2 Heparin 

Heparin adalah salah satu obat tertua yang tetap digunakan secara luas 

sebagai antikoagulan (Aláez-Versón, dkk., 2017). Heparin merupakan polimer 

linear yang terdiri dari unit berulang 1-4 asam iduronat dan glukosamin. Residu 

asam iduronat biasanya terdiri dari 90% L-asam iduronat (IdoA) dan 10% D- asam 

glukuronat (GlcA). Sedangkan, residu dari gula amino hanya D-glukosamina 

(GlcN). Heparin memiliki kerapatan muatan negatif tertinggi dari semua 

makromolekul biologis. Hal ini merupakan hasil dari tingginya kandungan gugus 

sulfo dan karboksil bermuatan negatif. Rata-rata heparin disakarida mengandung 

2,7 gugus sulfo (Capila dan Linhardt, 2002). Heparin diperoleh dari ekstrak paru 

sapi atau mukosa usus babi. Secara umum juga dapat ditemukan pada jaringan 

manusia dan sel radang seperti sel jaringan ikat (mast) (Mulyadi, 2015).  

Heparin adalah bagian dari keluarga molekul glikosaminoglikan, yang 

mencakup berbagai anggota yang terkait erat seperti heparin sulfat. Terdapat dua 

jenis heparin: UFH dan LMWH. UFH memiliki aktivitas biologis yang bervariasi 
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karena campurannya yang heterogen dari rantai polisakarida linier. LMWH adalah 

kelompok beragam senyawa yang berasal dari UFH. Sebagian besar diproduksi 

dengan berbagai teknik depolimerisasi kimia atau fisik, sementara beberapa 

diproduksi oleh depolimerisasi enzimatik. Karena perbedaan cara pembuatannya, 

LMWH tersedia dalam berbagai berat molekul dan campuran panjang rantai 

polisakarida. Sedangkan produknya berbeda secara signifikan dalam hal sifat 

farmakologisnya (Atallah, dkk., 2020). 

 

Gambar 2.1 Heparin disakarida (Guerrini, dkk., 2007) 
 

Heparin banyak digunakan untuk aktivitas antitrombotiknya. Secara khusus, 

digunakan dalam mengobati dan mencegah emboli paru, trombosis vena dalam, 

infark miokard, angina pectoris, dan trombosis arteri. Heparin dan molekul mirip 

heparin bekerja dengan mengikat residu lisil pada antitrombin dan mempercepat 

laju pembentukan kompleks. Terdapat bukti pada pasien kanker, bahwa 

penggunaan UFH dan LMWH memberikan keuntungan kelangsungan hidup yang 

lebih besar. Menariknya, tampaknya ada hubungan penting antara trombosis dan 

tumor kanker, dengan yang pertama berperan dalam patogenesis dan tumorigenesis. 

Hal ini telah menyebabkan penyelidikan penggunaan terapi potensial untuk agen 

antitrombotik dalam pengobatan kanker (Atallah, dkk., 2020).  

UFH adalah bentuk GAG alami yang paling sedikit diproses dan dihasilkan 

melalui pemurnian dari jaringan hewan, paling sering usus babi. Beberapa dekade 
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penelitian telah memberikan wawasan tambahan tentang struktur dan mekanisme 

aktivitas antikoagulannya. Sekarang diketahui bahwa heparin memberikan sifat 

antikoagulannya secara tidak langsung dengan mengikat antitrombin III (AT) dan 

memfasilitasi efek penghambatan AT berikutnya pada trombin dan faktor X yang 

diaktifkan (faktor Xa). Hanya UFH yang mengandung paling sedikit 18 rangkaian 

sakarida yang dapat mempengaruhi kerja AT pada trombin; namun, fragmen UFH 

dengan panjang berapa pun yang mengandung urutan pentasakarida unik dapat 

menghambat kerja faktor Xa (Guerrini, dkk., 2007). 

 

Gambar 2.2 Konformasi heliks heparin (Guerrini, dkk., 2007). 
 

Heparin adalah polisakarida linier, tidak bercabang, dan sangat sulfat yang 

diketahui memiliki struktur heliks. Interaksi heparin dengan beragam protein 

penting menunjukkan bahwa heparin menampilkan gugus sulfo dan karboksilnya 

dalam pola serta orientasi yang ditentukan untuk melakukan interaksi protein 

spesifik. Fleksibilitas konformasi residu L-asam iduronat dalam heparin 

bertanggung jawab atas berbagai interaksi protein spesifik yang ditunjukkan oleh 

keluarga GAG (Capila dan Linhardt, 2002). Beberapa studi telah difokuskan pada 



14 

 

penjelasan struktur persyaratan untuk mengikat FGF2 menunjukkan bahwa 

interaksi dimediasi pada dasarnya oleh kelompok N- dan 2-O-sulfat. Data juga 

menunjukkan bahwa kelompok 6-O-sulfat tidak diperlukan untuk pembentukan 

kompleks FGF2-GAG. Namun, kelompok ini memainkan peran penting dalam 

interaksi dengan reseptor. Persyaratan struktural lainnya adalah adanya residu IdoA 

dalam rantai GAG. Variasi urutan dicapai dengan substitusi satu atau lebih residu 

IdoA dengan residu GlcA dan menginduksi pengurangan afinitas oligosakarida 

terhadap FGF2 (Guerrini, dkk., 2007).  

 

Gambar 2.3 Konformasi residu heparin (Capila dan Linhardt, 2002). 
 

Analisis konformasi gula individu dalam heparin menunjukkan bahwa residu 

D-glukosamin dan asam D-glukuronat mengasumsikan konformasi 4C1 yang lebih 

disukai (Gambar 2.3 A). Fleksibilitas konformasi residu asam L-iduronat (IdoA) 

bervariasi, tergantung pada substitusi pola residu ini dan pada posisi relatifnya 

dalam rantai. Ketika residu IdoA berada di ujung pereduksi oligosakarida, data 

NMR menyarankan tiga kemungkinan konformer, yakni 4C1, 1C4 (kursi) dan 2S0 
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(perahu miring) (Gambar 2.3 B). Ketika residu IdoA internal, maka hanya 

konformasi 1C4 dan 2S0 yang dapat diakses. Untuk residu 2-O-sulfo-α-L 

idopyranosyluronate (IdoAp2S) juga kedua konformasi yang sama ini dapat diakses, 

dan studi NMR larutan pada heksasakarida turunan heparin menunjukkan bahwa 

residu IdoAp2S internal ada dalam keseimbangan antara kursi dan bentuk perahu 

miring. Bentuk 2S0 tampaknya sedikit disukai dalam hal stabilitas konformasi, 

karena cenderung meminimalkan interaksi tak-terikat 1,3 diaksial yang tidak 

diinginkan yang diharapkan dalam bentuk 1C4, di mana empat substituen 

berorientasi aksial dan hanya gugus karboksil yang ekuator. Namun, penghalang 

energi untuk bentuk 1C4 tidak tinggi, sehingga memungkinkan cincin iduronate 

untuk berubah antara bentuk 2S0 dan 1C4 sehingga dalam keadaan terikat protein 

dapat membuat interaksi elektrostatik yang menguntungkan dengan asam amino 

basa pada protein (Capila dan Linhardt, 2002). 

 

2.3 Kompleks FGF-FGFR 

Fibroblast growth factors (FGF) adalah keluarga dari 23 polipeptida yang 

terkait secara struktural yang terlibat dalam proses perkembangan dan fisiologis, 

termasuk proliferasi sel, diferensiasi, morfogenesis, dan angiogenesis. Cara kerja 

FGF adalah mengikat ke empat reseptor tirosin kinase transmembran yang berbeda 

dengan afinitas tinggi (FGFR1–FGFR4). Langkah pertama dari jalur sinyal spesifik 

dan respons biologis berikutnya disebut dengan dimerisasi FGF-FGFR. Membran 

sel heparan sulfat (HS) melindungi FGF dari denaturasi dan degradasi proteolitik 

meningkatkan afinitas FGF untuk reseptornya, memfasilitasi dan menstabilkan 

pembentukan oligomer FGF yang berorientasi dengan benar (Guerrini, dkk., 2007). 
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Gambar 2.4 Kompleks terner Heparin-FGF-FGFR (Schlessinger, dkk., 2000). 
 

Heparin eksogen bersaing dengan HS untuk mengikat FGF. Tergantung pada 

panjangnya, mengikat rantai heparin dapat bertindak baik sebagai inhibitor atau 

aktivator. Rantai heparin tersebut cukup panjang untuk mengikat lebih dari satu 

molekul FGF dan untuk mengatur dimer FGF atau oligomer yang lebih tinggi 

mendukung pembentukan kompleks terner dengan FGFR. Kompleks tersebut 

mendukung aktivasi reseptor akibatnya memberikan respon biologis. Heparin 

dengan rantai lebih pendek, ketika berinteraksi dengan FGF dapat menghambat 

perakitan kompleks terner dengan HS dan FGFR. Akibatnya menghambat respons 

biologis (Guerrini, dkk., 2007). Oleh karena itu, salah satu peran heparin dalam 

kompleks pensinyalan FGF adalah untuk meningkatkan stabilitas kompleks FGF-

FGFR biner dengan menghubungkan ligan dan reseptor silang. Interaksi yang 

berperan penting dalam mengikat sisi aktif pada FGFR1 yaitu Lys 160, Lys 163, 

Lys 172, dan Lys 177. Sedangkan interaksi pada FGF2 yaitu Asn 27, Arg 120, Thr 

121, Lys 125, Lys 129, Gln 134, Lys 135, dan Ala 136 (Mahdavi, dkk., 2017).  
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2.4 Penambatan Molekul (Docking) 

Pendekatan in silico dilakukan untuk eksperimen kering dengan 

menggunakan komputer. Metode untuk pendekatan ini yaitu penambatan molekul 

(Molecular Docking). Penambatan molekul merupakan prosedur komputasi yang 

digunakan untuk memprediksikan sebuah molekul besar (reseptor) dan molekul 

kecil (ligan) secara efisien, dimulai dari struktur-struktur yang tidak berikatan dari 

simulasi dinamika molekul, homology modelling, dan lain-lain (Yannuar, 2012). 

Fungsi docking adalah memprediksi orientasi molekul yang mengikat satu 

sama lain untuk membentuk kompleks yang stabil. Informasi tentang orientasi ini 

dapat digunakan untuk memprediksi kekuatan hubungan atau afinitas ikatan antara 

dua molekul. Hubungan antara molekul yang relevan secara biologis (seperti 

protein, asam nukleat, karbohidrat dan lipid) memainkan peran sentral dalam proses 

ini. Orientasi relatif dari kedua pasangan tersebut berpengaruh terhadap jenis sinyal 

yang dihasilkan. Docking dapat digunakan untuk memprediksi kekuatan dan jenis 

sinyal yang dihasilkan. Docking biasanya digunakan untuk memprediksi orientasi 

kandidat obat bermolekul kecil terhadap target protein untuk memprediksi afinitas 

dan aktivitas molekul, sehingga docking memainkan peran penting dalam desain 

obat yang rasional (Mukesh dan Rakesh, 2011). 

 

2.5 Simulasi Dinamika Molekul 

Simulasi dinamika molekul pertama kali dikembangkan pada akhir 70-an. 

Teknik ini telah berkembang dari simulasi beberapa ratus atom ke sistem dengan 

relevansi biologis, termasuk seluruh protein dalam larutan dengan representasi 

pelarut eksplisit, protein tertanam membran, atau kompleks makromolekul besar 
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seperti nukleosom atau ribosom. Simulasi dinamika molekul telah berkembang 

menjadi teknik yang dapat digunakan secara efektif untuk memahami hubungan 

struktur dan fungsi makromolekul. Waktu simulasi yang digunakan saat ini 

mendekati waktu yang relevan secara biologis. Informasi yang dikumpulkan 

tentang sifat dinamis makromolekul cukup kaya untuk mengubah paradigma 

bioinformatika struktural yang biasa dari mempelajari struktur tunggal menjadi 

menganalisis ansambel konformasi (Filipe dan Loura, 2022).  

Model awal sistem diperoleh dari struktur eksperimental atau data 

pemodelan komparatif. Sistem simulasi dapat direpresentasikan pada tingkat detail 

yang berbeda. Representasi atomistik adalah representasi yang mengarah pada 

reproduksi terbaik dari sistem aktual. Namun, representasi kasar menjadi sangat 

populer ketika sistem besar atau simulasi panjang diperlukan. Representasi pelarut 

adalah kunci dalam definisi sistem (Filipe dan Loura, 2022). 

 

2.5.1 Medan Gaya 

Dalam konteks pemodelan molekul, medan gaya mengacu pada bentuk dan 

parameter fungsi matematika yang digunakan untuk menggambarkan energi 

potensial dari sistem partikel (biasanya molekul dan atom). Fungsi medan gaya dan 

set parameter diturunkan dari pekerjaan eksperimental dan perhitungan mekanika 

kuantum tingkat tinggi. Medan gaya “All-Atom” memberikan parameter untuk 

setiap jenis atom dalam suatu sistem, termasuk hidrogen, sedangkan medan gaya 

“United-Atom” memperlakukan atom hidrogen dan karbon dalam gugus metil dan 

metilen sebagai pusat interaksi tunggal. Medan gaya “Coarse-Grained” sering 

digunakan dalam simulasi protein jangka panjang, memberikan representasi yang 
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lebih kasar untuk meningkatkan efisiensi komputasi (Sharma, dkk., 2019). Terdapat 

15 paket medan gaya yang disediakan pada Gromacs berupa AMBER, CHARMM, 

GROMOS, dan OPLS. Namun medan gaya lain dapat digunakan dengan 

menambahkan secara mandiri.   

 

2.5.2 Ensemble NVT 

Pada ensemble kanonik, volume sistem adalah tetap dan energi dapat 

berpindah melintasi batas antara sistem dan lingkungan, tetapi materi tidak. Kita 

dapat menggambarkan sistem sebagai terendam dalam penangas panas pada suhu 

(T), di mana penangas panas jauh lebih besar dari sistem. Tidak ada jumlah panas 

yang dilepaskan oleh sistem yang akan secara signifikan meningkatkan suhu 

lingkungan. Ensemble kanonik berlaku untuk sistem dengan ukuran berapa pun. 

Sementara perlu untuk mengasumsikan bahwa ukuran relatif dari penangas panas 

sangat besar, sistem itu sendiri mungkin kecil atau besar. Sekarang karena sistem 

dan lingkungan berada dalam kontak termal, sistem akan mentransfer panas (q) ke 

dan dari lingkungan sampai mereka berada dalam kesetimbangan termal. Oleh 

karena itu, tidak seperti ensemble mikrokanonik, suhu ensemble kanonik dapat 

berupa konstanta yang ditentukan (T). Ensemble ini sangat berguna untuk merawat 

sistem eksperimental aktual yang umumnya memiliki V, N, dan T tetap (Satoh, 

2003).  

 

2.5.3 Ensemble NPT 

Pada ensemble isotermal-isobarik, energi dapat berpindah melintasi batas, 

tetapi materi tidak. Volume sistem dapat berubah sedemikian rupa sehingga tekanan 
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internal sistem sesuai dengan tekanan yang diberikan pada sistem oleh 

lingkungannya. Mirip dengan ensemble kanonik, kita dapat menggambarkan 

ansambel isotermal-isobarik sebagai sistem yang direndam dalam penangas panas 

pada suhu (T), di mana penangas panas jauh lebih besar daripada sistem. Tidak ada 

jumlah panas yang dilepaskan oleh sistem yang akan secara signifikan 

meningkatkan suhu lingkungan. 

Ensembel isotermal-isobarik adalah ansambel mekanik statistik yang 

mempertahankan jumlah total partikel yang konstan, dan suhu (T) dan tekanan (p) 

yang konstan, biasanya disingkat NPT. Ansambel ini sangat berguna untuk 

menangani sistem fisik dimana volume sistem berfluktuasi, meskipun tekanan 

dijaga konstan (Satoh, 2003). 

 

2.6 Teknik Simulasi Dinamika Molekul 
2.6.1 Kotak Simulasi 

Kotak simulasi merupakan suatu proses peniruan dari sesuatu yang nyata 

beserta keadaan sekelilingnya dalam suatu kotak. Pada Gromacs terdapat beberapa 

jenis kotak simulasi seperti kotak kubik/persegi panjang, oktahedron terpotong, 

prisma heksagonal, dan dodecahedron belah ketupat. Sel kubik adalah sistem 

periodik paling sederhana untuk divisualisasikan dan diprogram. Namun, sel 

dengan bentuk yang berbeda mungkin lebih sesuai untuk simulasi yang diberikan. 

Ini mungkin sangat penting untuk simulasi sistem yang terdiri dari molekul tunggal 

atau kompleks antarmolekul yang dikelilingi oleh molekul pelarut. Pada sistem 

seperti itu biasanya perilaku molekul zat terlarut pusat yang paling menarik, 

sehingga diinginkan bahwa waktu komputer sesedikit mungkin dihabiskan untuk 

mensimulasikan pelarut jauh dari zat terlarut. Pada prinsipnya, setiap bentuk sel 
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dapat digunakan asalkan mengisi semua ruang dengan operasi translasi kotak pusat 

dalam tiga dimensi. Lima bentuk memenuhi kondisi ini: kubus (dan hubungan 

dekatnya, paralelepiped), prisma heksagonal, oktahedron terpotong, dodecahedron 

belah ketupat dan dodecahedron 'memanjang' (Leach, 2001). 

Dari lima kemungkinan bentuk, kubus/paralelepiped dan oktahedron 

terpotong paling banyak digunakan, dengan beberapa simulasi dalam prisma 

heksagonal. Mungkin lebih baik menggunakan salah satu sel periodik yang lebih 

umum bahkan jika ada alasan estetika untuk menggunakan alternatif. Ini karena 

ekspresi untuk menghitung gambar mungkin sulit dan tidak efisien untuk 

diterapkan, meskipun simulasi akan menggunakan lebih sedikit atom (Leach, 2001). 

 

2.6.2 PBC 

Periodic boundary conditions (PBC) memungkinkan simulasi dilakukan 

dengan menggunakan jumlah partikel yang relatif kecil, sedemikian rupa sehingga 

partikel mengalami gaya seolah-olah berada dalam fluida. Bayangkan sebuah kotak 

kubik partikel yang direplikasi ke segala arah untuk memberikan susunan periodik. 

Sebuah kotak dua dimensi ditunjukkan pada Gambar 2.7. Pada contoh dua dimensi 

setiap kotak dikelilingi oleh delapan tetangga. Sedangkan dalam tiga dimensi setiap 

kotak akan memiliki 26 tetangga terdekat. Koordinat partikel dalam kotak gambar 

dapat dihitung hanya dengan menambahkan atau mengurangkan kelipatan integral 

dari sisi kotak. Jika sebuah partikel meninggalkan kotak selama simulasi maka akan 

digantikan oleh partikel gambar yang masuk dari sisi yang berlawanan, seperti yang 

diilustrasikan pada Gambar 2.7. Dengan demikian, jumlah partikel di dalam kotak 

pusat tetap konstan. Perhitungan dalam PBC hanya menghitung interaksi antar 
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partikel yang berbeda, tidak menghitung interaksi antara atom yang sama (hasil 

replikasi) (Leach, 2001). 

 
Gambar 2.5 PBC dalam dua dimensi (Leach, 2001). 

 

2.7 Tahapan Simulasi Dinamika Molekul 
2.7.1 Inisiasi 

Sebelum simulasi dapat dilakukan, perlu untuk memilih konfigurasi awal 

sistem. Simulasi sistem pada kesetimbangan adalah memilih konfigurasi awal yang 

dekat dengan keadaan yang diinginkan untuk disimulasikan. Jika pengaturan yang 

ditentukan secara eksperimental tersedia maka dapat digunakan, asalkan sesuai 

dengan simulasi yang dilakukan. Ketika tidak ada struktur eksperimental yang 

tersedia, konfigurasi awal dapat dipilih dari salah satu kisi kristalografi umum. Kisi 

yang paling umum adalah kisi kubik berpusat muka. Ukuran kisi dipilih sehingga 

densitasnya sesuai dengan sistem yang diteliti. Pada simulasi molekul, juga perlu 

menetapkan orientasi untuk setiap molekul. Sedangkan untuk molekul linier kecil, 

struktur padat CO2 sering dipilih sebagai konfigurasi awal. Ini adalah kisi kubik 

berpusat muka dengan molekul yang berorientasi secara teratur di sepanjang empat 

diagonal sel satuan. Orientasi dapat dipilih sepenuhnya secara acak atau dengan 

membuat perubahan acak kecil dari orientasi dalam kisi biasa. Pada kepadatan 

tinggi, tumpang tindih non-fisik dapat terjadi, terutama jika molekulnya besar; 
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dalam kasus seperti itu lebih penting untuk menggunakan konfigurasi awal yang 

dekat dengan distribusi ekuilibrium yang diharapkan (Leach, 2001). 

 

2.7.2 Ekuilibrasi 

Tujuan dari fase ekuilibrasi adalah untuk memungkinkan sistem berevolusi 

dari konfigurasi awal untuk mencapai keseimbangan. Ekuilibrasi harus berlanjut 

sampai nilai dari sekumpulan properti yang dipantau menjadi stabil. Sifat-sifat yang 

akan dipantau biasanya meliputi besaran termodinamika seperti energi, suhu dan 

tekanan serta sifat-sifat struktural. Dalam cairan, bagaimanapun, kita akan 

mengharapkan mobilitas yang cukup besar dari spesies yang ada, sehingga 

menimbulkan gangguan translasi (Leach, 2001).  

 

2.7.3 Produksi 

Selama fase produksi, sifat sederhana dari sistem dihitung menggunakan 

parameter ansambel NPT. Pada interval reguler, konfigurasi sistem (yaitu koordinat 

atom) dikeluarkan ke file trajectory. Hasil produksi simulasi dianalisis untuk 

menemukan bagaimana struktur sistem berubah dan memeriksa perilaku yang tidak 

biasa yang mungkin menunjukkan masalah dengan simulasi (Leach, 2001). 

 

2.8 Analisis 
2.8.1 RMSD 

Salah satu parameter penting untuk menganalisis kompleks protein-ligan 

adalah RMSD dari atom C-α backbone protein yang mencirikan stabilitas 

konformasi keseluruhannya dalam keadaan dinamis selama simulasi. Sistem 

diseimbangkan dan distabilkan ketika memperoleh tingkat RMSD yang rendah 
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dengan fluktuasi yang konsisten untuk seluruh simulasi. Fluktuasi yang lebih tinggi 

menunjukkan stabilitas yang rendah. Grafik RMSD yang sangat menyimpang juga 

dapat menyiratkan transisi konformasi utama yang terjadi dalam protein untuk 

mendapatkan konformasi yang stabil dengan ligan (Sharma, dkk., 2021). 

 

2.8.2 RMSF 

Residu protein memainkan peran penting dalam mencapai konformasi yang 

stabil untuk kompleks protein-ligan dan dapat diukur dengan menggunakan RMSF 

sebagai parameter. RMSF residu pada dasarnya menganalisis segmen tertentu dari 

protein yang menyimpang dari struktur rata-ratanya yang umumnya terjadi pada 

interaksi ligan. Fluktuasi yang diamati untuk setiap residu menandakan tingkat 

fleksibilitas yang diperoleh oleh mereka. Jadi residu atau sekelompok residu yang 

menunjukkan tingkat RMSF yang lebih tinggi menyiratkan peningkatan 

fleksibilitas yang pada gilirannya menunjukkan peningkatan potensi mereka untuk 

berinteraksi dengan molekul ligan. Demikian pula, fluktuasi RMSF yang lebih 

rendah menyiratkan fleksibilitas yang lebih rendah, sehingga mengurangi potensi 

interaksi (Sharma, dkk., 2021). 

 

2.9 Aplikasi Komputasi 
2.9.1 Gromacs 

GROMACS adalah singkatan dari GROningen MAChine for Chemical 

Simulation. Nama itu muncul dari proyek kolaborasi di Departemen Kimia 

Universitas Groningen, Belanda, dengan Departemen Ilmu Komputer di Groningen 

pada awal 1990-an untuk membangun sebuah sistem komputer paralel khusus 

untuk simulasi molekuler. Karena GROMACS telah dikembangkan seluruhnya 
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dalam proyek-proyek yang didanai publik, diputuskan untuk menawarkan 

perangkat lunak di bawah GNU General Public License (GPL). Ini menjamin tidak 

hanya akses terbuka untuk komunitas ilmiah, tetapi juga ketersediaan kode sumber 

(Van Der Spoel, dkk., 2005). 

GROMACS bertujuan untuk menyediakan program MD yang serbaguna dan 

efisien dengan kode sumber, terutama diarahkan pada simulasi molekul biologis 

(makro) dalam lingkungan berair dan membran, dan mampu berjalan pada prosesor 

tunggal serta pada sistem komputer paralel. Ini tidak hanya menyediakan mekanika 

Hamiltonian mikrokanonik, tetapi juga dinamika stokastik termasuk dinamika 

Langevin dan Brownian, dan minimisasi energi. Berbagai metode kopling untuk 

suhu dan tekanan disertakan, juga memungkinkan tekanan anisotropik dan 

perubahan kotak triklinik dalam menanggapi fluktuasi tensor tekanan. Kekuatan 

eksternal dapat diterapkan untuk menegakkan dinamika nonequilibrium atau "MD 

yang dikemudikan." Atom dapat diatur dalam kelompok khusus untuk tujuan 

partisipasi selektif dalam dinamika atau analisis rinci energi. Ada juga ketentuan 

untuk penggunaan situs virtual, yaitu situs interaksi tak bermassa yang dibangun 

dari posisi atom. Paket program mencakup berbagai macam alat analisis, mulai dari 

analisis lintasan grafis ekstensif hingga mode normal dan analisis komponen utama 

fluktuasi struktural. Lihat Lampiran untuk daftar fitur (Van Der Spoel, dkk., 2005). 

 

2.9.2 Grace 

Grace (Graphing, Advanced Computation and Exploration of data) adalah 

alat plotting grafik 2D untuk sistem operasi mirip Unix. Grace menggunakan 

Sistem X Window dan Motif untuk GUI-nya. Pada tahun 1996, Linux Journal 



26 

 

menggambarkan Xmgr (nama awal untuk Grace) sebagai salah satu dari dua paket 

grafik paling menonjol untuk Linux. Grace dapat digunakan dari antarmuka point-

and-click atau skrip (menggunakan bahasa pemrograman built-in atau sejumlah 

binding bahasa). Ini melakukan baik kuadrat terkecil linier dan nonlinier yang 

sesuai dengan fungsi yang ditentukan pengguna yang kompleks secara sewenang-

wenang, dengan atau tanpa kendala. Alat analisis lainnya termasuk FFT, integrasi 

dan diferensiasi, splines, interpolasi, dan smoothing (Vaught, 1996). 

 

2.9.3 VMD 

VMD (Visual Molecular Dynamics) adalah program grafis molekuler yang 

dirancang untuk tampilan dan analisis molekul, khususnya biopolimer seperti 

protein dan asam nukleat. VMD dapat secara bersamaan menampilkan sejumlah 

struktur menggunakan berbagai gaya rendering dan metode pewarnaan. Molekul 

ditampilkan sebagai satu atau lebih "representasi", dimana setiap representasi 

mewujudkan metode rendering tertentu dan skema pewarnaan untuk subset atom 

yang dipilih. Atom yang ditampilkan dalam setiap representasi dipilih 

menggunakan sintaks pemilihan atom ekstensif yang mencakup operator Boolean 

dan ekspresi reguler. VMD menyediakan antarmuka pengguna grafis lengkap untuk 

kontrol program, serta antarmuka teks menggunakan parser yang dapat disematkan 

Tcl untuk memungkinkan skrip kompleks dengan substitusi variabel, loop kontrol, 

dan panggilan fungsi. Pencatatan sesi penuh didukung, yang menghasilkan skrip 

perintah VMD untuk pemutaran nanti. Gambar raster resolusi tinggi dari molekul 

yang ditampilkan dapat dihasilkan dengan menghasilkan skrip input untuk 

digunakan oleh sejumlah aplikasi perenderan gambar fotorealistik. VMD juga telah 
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dirancang dengan kemampuan untuk menganimasikan lintasan simulasi dinamika 

molekul (MD), diimpor baik dari file atau dari koneksi langsung ke simulasi MD 

yang sedang berjalan. VMD adalah komponen visualisasi MDScope, seperangkat 

alat untuk pemecahan masalah interaktif dalam biologi struktural, yang juga 

mencakup program MD paralel NAMD, dan perangkat lunak MDCOMM yang 

digunakan untuk menghubungkan program visualisasi dan simulasi. VMD ditulis 

dalam C++, menggunakan desain berorientasi objek program, termasuk kode 

sumber dan dokumentasi ekstensif (Humphrey, dkk., 1996). 

 

2.9.4 Discovery Studio 

Discovery studio merupakan perangkat lunak paling komprehensif, terukur, 

dan kolaboratif untuk penelitian dalam bidang ilmu hayati. Discovery studio 

merupakan salah satu program visualisasi molekul kecil dan besar. Visualisasi 

dapat berupa molekul 2D atau 3D dalam menampilkan interaksi ligan-protein 

(Ahkam, dkk., 2020). 

 

2.9.5 PyMol 

PyMOL adalah sistem visualisasi molekuler tidak berbayar yang banyak 

digunakan untuk visualisasi tiga dimensi (3D) protein, asam nukleat, molekul kecil, 

kerapatan elektron, mengedit molekul, dan membuat film hasil visualisasi. 

Perangkat lunak berbasis Python ini, telah dikembangkan untuk meningkatkan 

utilitasnya dan memfasilitasi desain obat di PyMOL. PyMOL dapat menghasilkan 

film dan gambar makromolekul berkualitas tinggi dalam berbagai representasi 

termasuk pita, kartun, titik, permukaan, bola, tongkat, dan garis (Yuan, dkk., 2017). 
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BAB III 

METODE PERCOBAAN 

 

3.1 Pelaksanaan Penelitian 

Penelitian ini akan dilakukan di Laboratorium Kimia Komputasi Program 

Studi Kimia Fakultas Sains dan Teknologi Universitas Islam Negeri Maulana Malik 

Ibrahim Malang pada Januari – April 2023 .  

 

3.2 Alat dan Bahan  
3.2.1 Alat  

Perangkat keras yang digunakan dalam penelitian ini adalah HP Laptop 14s-

fq1006AU dengan spesifikasi AMD Ryzen 5 5500U dengan grafik radeon 12 CPU 

2.1 GHz RAM 8,00 GB. 

Perangkat lunak yang digunakan yaitu sistem operasi Windows 11 Home 

Single Language 64-bit 10.0 Build 22000, Ubuntu 20.04 on windows, Gromacs 

2020.1, Grace 5.1.25, VMD 1.9.4, Discovery Studio 2021, UCSF Chimera, 

AutodockTools 4.2, dan PyMol 2.5.4. 

 

3.2.2 Bahan  

Bahan yang digunakan dalam penelitian ini berupa molekul tiga dimensi 

reseptor FGFR1-FGF2 dengan kode ID 1FQ9 serta ligan uji heparin 8 dan 12 

sakarida 2S konformasi 1C4 dengan kode ID 1HPN dalam format .pdb. 
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3.3 Rancangan Penelitian 

Penelitian ini dilakukan secara in silico menggunakan komputer. Bahan 

penelitian menggunakan reseptor dengan PDB ID 1FQ9, karena model ini 

memberikan dasar struktural untuk aktivasi FGFR oleh heparin molekul kecil dan 

dapat memfasilitasi desain heparin yang mampu memodifikasi sinyal FGF 

(Schlessinger, dkk., 2000). Sedangkan ligan yang digunakan adalah struktur dengan 

PDB ID 1HPN, karena merupakan struktur yang memiliki kemungkinan sebagai 

senyawa antikanker (Cole, dkk., 2010). Struktur yang diinginkan di persiapkan 

pada Chimera. Tahap selanjutnya yaitu proses molecular docking menggunakan 

Autodock 4.2. Proses ini melalui beberapa tahapan seperti persiapan ligan dan 

reseptor, penentuan kotak grid (Grid box), docking, dan run. Adapun proses 

persiapan ligan dan reseptor dengan minimasi molekul air, penyempurnaan atom 

hidrogen, penataan muatan atomik, penentuan torsi pada ligan, dan Set Rigid 

Filename pada makromolekul. Proses grid dilakukan setelah persiapan struktur usai 

dengan memilih kotak grid aktif. Selanjutnya struktur dilakukan proses docking 

dengan pemilihan parameter Genetic Algorithm dan Lamarckian GA. Tahap 

terakhir dari proses ini yaitu running menggunakan Command Prompt. Running 

dilakukan dua cara yaitu eksekusi terhadap kotak grid dan eksekusi docking dengan 

optimasi 200. 

Selanjutnya kompleks hasil docking dengan energi terendah dipreparasi 

untuk simulasi dinamika molekul. Pertama kompleks hasil docking dipreparasi 

pada situs Charmm-GUI. Selanjutnya diatur kotak simulasi sebesar 15Å. Kemudian 

ditambahkan ion Na+ dan Cl- untuk menstabilkan muatan. Hasil preparasi berupa 

file .tgz diekstrak kemudian dilakukan minimalisasi energi. Selanjutnya tahap 
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equilibrasi menggunakan ensemble NVT (volume dan temperatur konstan) dan 

ensemble NPT (tekanan dan temperatur konstan) selama 2 ns. Suhu dan tekanan 

sistem diseimbangkan pada 310K dan 1 atm. Persamaan gerak diintegrasikan pada 

langkah waktu 2 fs, memperbarui daftar tetangga setiap 5 langkah. Akhirnya 

kompleks terlarut dan seimbang ini dimasukkan ke fase produksi selama 100 ns 

untuk menghasilkan berkas trajectory.  

Hasil simulasi dinamika molekul dapat divisualisasikan dengan 

menggunakan Discovery Studio Visualizer (DSV) serta Visual Molecular Dynamics 

(VMD). Visualisasi menggunakan DSV bertujuan untuk mengetahui perubahan 

interaksi ligan dengan reseptor berdasarkan panjang ikatan, distribusi atom, dan 

asam amino yang terikat. Sedangkan analisis menggunakan VMD bertujuan untuk 

mengetahui pergerakan dari molekul selama waktu simulasi berupa animasi.   

Berkas trajectory dianalisis menggunakan Gromacs untuk mengetahui 

RMSD, RMSF, dan interkasi residu asam aminonya. Analisis RMSD dilakukan 

untuk mengamati perubahan konformasi yang terjadi selama simulasi. Sedangkan 

analisis RMSF dilakukan untuk mengidentifikasi bagian fleksibel dalam molekul. 

Nilai RMSF yang rendah dianggap memiliki kestabilan yang lebih baik (Fakih, 

dkk., 2020). Berkas hasil analisis di visualisasikan menggunakan Grace.  

 

3.4 Tahapan penelitian 

Tahapan dalam penilitan ini adalah:  

a) Preparasi Makromolekul FGF2-FGFR1 

b) Preparasi Ligan Heparin 

c) Validasi Penambatan Ulang Molekul (Redocking) 
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d) Penambatan Molekul (Molecular Docking) 

e) Analisis Hasil Docking 

f) Preparasi Dinamika Molekul 

g) Simulasi Dinamika Molekul 

h) Analisis 

 

3.5 Prosedur penelitian  
3.5.1 Preparasi Makromolekul FGF2-FGFR1 

Struktur protein diunduh pada situs www.rcsb.org/pdb, dengan kode PDB 

1FQ9 dan dibuka pada aplikasi UCSF Chimera. Data makromolekul disimpan 

dalam format .pdb. selanjutnya, dilakukan penghapusan ligan dengan File → Open 

→ Select → Structure → protein → Invert (selected models) → Atoms/Bonds → 

delete. Setelah itu ligan dan reseptor ditambahkan hidrogen dan muatan di Chimera, 

dengan Tools → Structre Editing → Add H → OK dan Structre Editing → Add 

Charge → OK. File disimpan dalam format .pdb. 

 

3.5.2 Preparasi Ligan Heparin 

Ligan yang digunakan adalah senyawa heparin yang diunduh dari situs PDB 

(http://www.rcsb.org). Kode PDB yang digunakan adalah 1HPN. Setelah itu 

divisualisasikan pada aplikasi Pymol. diambil model 2 yang berbentuk 1C4. 

Dipotong senyawa SO3 pada SGN dan ditambah hidrogen dengan (h_add). 

Senyawa heparin dipotong menjadi 8 dan 12 mer, dan disimpan dalam bentuk PDB.  
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3.5.3 Validasi Penambatan Ulang Molekul (Redocking) 

Proses redocking ini dilakukan dengan cara menambatkan ulang ligan natif 

pada makromolekul FGFR1-FGF2. Ligan yang akan berinteraksi dengan protein 

dibuat fleksibel dengan makromolekul yang rigid.  

1. Persiapan ligan-reseptor  

File ligan dibuka dalam bentuk PDB, kemudian klik edit → delete water, 

penetapan jenis atom (Assign AD4 type), dan pemilihan muatan (Compute 

Gasteiger). Tahap berikutnya klik Ligand → Input → Choose ligand → Select dan 

Input → Torsion Tree → Choose root → Detect root kemudian disimpan dalam 

format .pdbqt.  

2. Penentuan Grid box  

Menentukan sisi pengikatan protein dengan klik grid → Macromolecule → 

Choose. lalu, pilih Set Map Types → Open Ligand dan Set Map Types → Choose 

Ligand → klik ligand → Select. Pada penentuan posisi aktif pengikatan molekul 

dengan klik Grid diatur grid box pada X: 80,459, Y: 23,095, Z: 104,054 dan volume 

grid sebesar 90 x 90 x 90 Å, dengan spacing 0,375 (default) lalu disimpan ke bentuk 

grid parameter file (GPF).  

3. Proses redocking  

Proses penambatan ini menggunakan parameter Genetic Algorithm dan 

Lamarckian GA. Dengan langkah awal memilih Macromolecule → pilih Set Rigid 

Filename dan pilih Ligand → Choose → Select → Accepted. Kemudian klik Search 

Paramters → Genetic Algorithm → number runs of GA 200 → Docking 

Parameters → Accepted dan Output → Lamarckian GA, setelah itu file disimpan 

dalam bentuk docking parameter file (DPF).  
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4. Running  

Pada proses running redocking ini menggunakan Command Prompt untuk 

Autogrid (autogrid4 -p file.gpf -l file.glg) sehingga dihasilkan grid log file (GLG) 

dan Autodock (autodock4 -p file.dpf -l file.dlg) dihasilkan docking log file (DLG). 

 

3.5.4 Penambatan Molekul 

Penambatan molekul dilakukan pada ligan uji heparin 8 mer 2S dan 12 mer 

2S yang telah dipreparasi pada reseptor FGFR1-FGF2 menggunakan aplikasi 

Autodock Tools dengan prosedur yang sama dengan validasi penambatan ulang 

molekul. Pengaturan gridbox untuk senyawa 8 mer 2S adalah  X: 88,459, Y: 27,095, 

Z: 111,053 dan volume grid sebesar 126 x 126 x 126 Å, dengan spacing 0,375 

(default). Sedangkan untuk senyawa 12 mer 2S menggunakan pengaturan X: 82,54, 

Y: 26,378, Z: 111,967. 

 

3.5.5 Analisis Hasil Docking 

Visualisasi Interaksi hasil docking dilakukan menggunakan apilkasi 

AutodockTools dan Discovery Studio Visualizer. Visualisasi menggunakan 

AutodockTools digunakan untuk mengetahui konformasi dan energi binding tiap 

sakarida. Program AutodockTools dibuka, lalu kompleks hasil penambatan 

molekul dibuka dengan klik Analyze → Dockings → Open, format file dalam 

bentuk .dlg. Selanjutnya klik Analyze → Macromolecule → Open. Terakhir, klik 

Analyze → Conformations → Play → Load. Simpan molekul hasil docking dalam 

bentuk file .pdb.  
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Discovery Studio digunakan untuk mengetahui jarak dan jumlah ikatan 

senyawa hasil docking. Discovery Studio dibuka, lalu kompleks hasil penambatan 

molekul dibuka dengan klik file dengan format file .pdb. Selanjutnya pilih ligand-

interaction untuk menampilkan visualisasi dalam bentuk 3D. 

 

3.5.6 Preparasi Simulasi Dinamika Molekul 

Preparasi simulasi dinamika molekul dilakukan dengan modul Glycan Reader 

& modeler pada situs  https://www.charmm-gui.org/. Kompleks hasil docking 

dengan format .pdb dikirim pada web. File .pdb → Model/Chain Selection Option

→ PDB Manipulation → Generate PDB → Water Box Size, Ukuran kotak 15Å → 

Add Ions, ditambahkan ion Na+ dan ion Cl- → Solvate Molecule → File Input, pilih 

Gromacs → Suhu simulasi 310K → Download .tgz file.  

 

3.5.7 Simulasi Dinamika Molekul 
3.5.7.1 Minimalisasi Energi 

Minimisasi energi bertujuan untuk menghindari bentrokan antar atom ketika 

terjadi proses penambahan dan pemutusan ikatan hidrogen. Parameter yang 

digunakan adalah file berformat .mdp dengan metode steepest descents untuk 

meminimalkan energi, dan untuk menghentikan proses jika besarnya gradien energi 

potensial sebesar 1000,0 kJ mol-1 nm-1 atau lebih kecil. Ukuran langkah maksimum 

sepanjang gradien adalah 0,02 nm, dan maksimum 50000 langkah diperbolehkan 

(Lemkul, 2019). Masukkan perintah pada terminal berupa: 

$ gmx grompp -f step4.0_minimization.mdp -o step4.0_minimization.tpr -c 

step3_input.gro -r step3_input.gro -p topol.top -n index.ndx -maxwarn -1 

$ gmx mdrun -v -deffnm step4.0_minimization 
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3.5.7.2 Ekuilibrasi 

Tahap ekuilibrasi dilakukan menggunakan volume yang konstan dan suhu 

pada 310K (NVT), karena suhu tubuh manusia berkisar 36-37°C (Geneva, dkk., 

2019). Ekuilibrasi dilakukan selama 2 ns. Masukkan perintah pada terminal berupa: 

$ gmx grompp -f step4.1_equilibration.mdp -o step4.1_equilibration.tpr -c 

step4.0_minimization.gro -r step3_input.gro -p topol.top -n index.ndx 

$ gmx mdrun -v -deffnm step4.1_equilibration 

 
3.5.7.3 Produksi 

Produksi dilakukan dengan pembuatan file input .tpr dengan grompp, yang 

memberikan koordinat dan file checkpoint dari ekuilibrasi untuk memastikan 

kelanjutan yang tepat (Lemkul, 2019). Produksi dinamika molekul dilakukan 

selama 100 ns menggunakan program mdrun. Masukkan perintah pada terminal 

berupa : 

$ gmx mdrun -deffnm md gmx grompp -f step5_production.mdp -o step5_1.tpr -c 

step4.1_equilibration.gro -p topol.top -n index.ndx  

$ gmx mdrun -v -deffnm step5_1   

 

3.5.8 Analisis  

Berkas PDB hasil simulasi di analisis menggunakan DSV untuk mengetahui 

jarak dan jumlah ikatan hidrogen, elektrostatik, interaksi pi-pi, interaksi pi-alkil, 

interaksi pi-kation, dll. Discovery Studio dibuka, lalu kompleks hasil simulasi 

dinamika molekul dibuka dengan klik file dengan format file .pdb. Selanjutnya pilih 

ligand-interaction untuk menampilkan visualisasi dalam bentuk 2D atau 3D.   
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Berkas trayektori dari hasil running dinamika molekular divisualisasikan 

menggunakan perangkat lunak VMD 1.9.4 untuk memberikan gambaran 

pergerakan molekul selama simulasi terjadi. Sebelum senyawa dianalisis secara 

visual, protein ditata ulang letaknya karena selama simulasi protein akan bergerak 

keluar dari box. Program yang digunakan adalah trjconv. Masukkan perintah pada 

terminal berupa : 

$ gmx trjconv -s md.tpr -f md.xtc -o md_center.pdb -center -pbc mol -ur compact 

Pilih “Protein” kemudian pilih “System” untuk output. Kemudian buka VMD 

kemudian masukkan file md_center.pdb untuk melihat animasi hasil simulasi 

.  

3.5.8.1 RMSD 

Program GROMACS yang menghitung RMSD disebut rms. Program tersebut 

membaca koordinat referensi, massa, dan topologi dari file .tpr yang diteruskan ke 

-s dan menghitung RMSD untuk setiap frame yang ditemukan dalam lintasan yang 

diteruskan ke -f (Lemkul, 2019). Masukkan perintah pada terminal berupa : 

$ gmx rms -s md.tpr -f analysis.xtc -o rmsd.xvg -tu ns 

Pilih “Backbone” untuk square fit. Kemudian pilih “Backbone” untuk 

perhitungan RMSD. Output dari langkah ini berupa berkas rmsd.xvg. Grafik RMSD 

ditampilkan menggunakan perangkat lunak Grace.  

$ xmgrace rmsd.xvg 
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3.5.8.2 RMSF 

RMSF merekam fluktuasi dari setiap atom tentang posisi rata-ratanya. Hal ini 

memberikan wawasan tentang fleksibilitas daerah peptida. RMSF dihitung 

menggunakan gmx rmsf. Masukkan perintah pada terminal berupa : 

$ gmx rmsf -s md.tpr -f analysis.xtc -o rmsf.xvg -res 

Pilih “Backbone” untuk perhitungan RMSF. Output dari langkah ini berupa 

berkas rmsf.xvg. Grafik RMSD ditampilkan menggunakan perangkat lunak Grace. 

Masukkan perintah pada terminal berupa : 

$ xmgrace rmsf.xvg 
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BAB V 

KESIMPULAN DAN SARAN 
 

5.1 Kesimpulan 

Berdasarkan penelitian yang dilakukan dapat disimpulkan : 

a. Perubahan struktur kompleks FGFR1-FGF2-heparin 8 mer 2S stabil mulai 

dari 25 ns hingga akhir simulasi dengan nilai RMSD protein sebesar 0-0.97 

nm. Sedangkan kompleks FGFR1-FGF2-heparin 12 mer 2S mengalami 

perubahan yang fluktuatif diawal simulasi kemudian stabil pada 45 ns terakhir 

dengan nilai RMSD protein sebesar 0-0.89 nm. 

b. Ligan heparin 12 mer 2S memiliki potensi lebih besar daripada ligan heparin 

8 mer 2S sebagai antikanker karena kemampuannya dalam menjaga 

kestabilan ikatannya dalam membentuk kompleks dengan FGFR1-FGF2. 

 
5.2 Saran 

Perlu dilakukan analisis MMPBSA untuk mengetahui perbedaan energi 

ikatan sebelum dan sesudah simulasi dinamika molekul.
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LAMPIRAN 

 
Lampiran 1. Rancangan Penelitian 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Preparasi docking 

Validasi metode 
docking (Redocking) 

Docking ligan uji 

Visualisasi hasil docking 

Preparasi simulasi 
dinamika molekul 

 

Minimisasi energi  

Ekuilibrasi selama 2 
ns hingga suhu 

  
 

Running selama 100 ns 

Analisis 
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Lampiran 2. Diagram Alir 

L.2.1 Preparasi Reseptor 
 

 
− Dibuka di chimera  
− Dihapus ligan 
− Ditambahkan hidrogen 
− Ditambahkan muatan 
− Disimpan dalam format .pdb 
− Dibuka pada AutodockTools 
− Disimpan dalam format .pdbqt 

 
 
L.2.2 Preparasi Ligan 
 

 
− Dibuka di dicovery studio 
− Dihapus model 1 
− Dipotong senyawa SO3 pada SGN 
− Ditambahkan  hidrogen 
− Disimpan dalam format .pdb 
− Ditambah muatan gasteiger 
− Diatur atom Assign AD4 
− Disimpan dalam format .pdbqt 

 
 
  

Struktur 1FQ9 

Hasil 

Struktur 1HPN 

Hasil 
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L.2.3 Docking 
 

 
− Dibuka .pdbqt pada AutodockTools 
− Diatur gridcenter pada X: 88.459 Y: 27.095 Z: 111.053 untuk ligan 

heparin 8 mer 2S, dan X: 88.54 Y: 26.378 Z: 111.967 untuk ligan 12 mer 
2S 

− Disimpan pada format .gpf 
− Dipilih makromolekul kaku untuk docking 
− Dipilih parameter Genetic Algorithm 
− Diatur Number of GA runs 200 
− Diatur docking parameter default 
− Dipilih Lamarckian GA 
− Disimpan dalam format .dpf 
− Dibuka command prompt 
− Dilakukan running autogrid4.exe -p docking.gpf -l docking.glg 
− Dilakukan running autodock4.exe -p docking.dpf -l docking.dlg 

 
 
L.2.4 Preparasi Simulasi Dinamika Molekul 
 

 
− Dibuka CHARMM-GUI 
− Dikirim struktur hasil docking 
− Model/Chain Selection Option 
− PDB Manipulation  
− Generate PDB  
− Diatur kotak simulasi sebesar 15 Å 
− Ditambahkan ion Na+ dan Cl-  
− Ditambah pelarut berupa air 
− Diatur input Gromacs 
− Diatur suhu 310° K 
− Download file .tgz 

 
 
  

Ligan dan Reseptor 

Hasil 

Kompleks hasil docking 

Hasil 
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L.2.5 Simulasi Dinamika Molekul 
 

 
− Dibuka gromacs 
− Dilakukan minimalisasi energi 
− Dilakukan ekuilibrasi 
− Dilakukan produksi 
− Diperoleh file .xtc dan .tpr 

 
 
L.2.6 Analisis 
 
a. RMSD Backbone Protein 

 
− Dibuka analysis.xtc dan md.tpr pada gromacs 
− Dianalisis RMSD menggunakan rms 
− Dipilih backbone 
− Diperoleh rmsd_protein.xvg 
− Dibuka rmsd_protein.xvg pada Grace 

 
 
b. RMSD Ligan Heparin 

 
− Dibuka analysis.xtc dan md.tpr pada gromacs 
− Dianalisis RMSD menggunakan rms 
− Dipilih ligan (asam iduronat dan glukosamin)  
− Diperoleh rmsd_ligan.xvg 
− Dibuka rmsd_ligan.xvg pada Grace 

 
 

  

File input 

Hasil 

analysis.xtc dan md.tpr 

Hasil 

analysis.xtc dan md.tpr 

Hasil 
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c. RMSD Asam Iduronat  

 
− Dibuka analysis.xtc dan md.tpr pada gromacs 
− Dianalisis RMSD menggunakan rms 
− Dipilih asam iduronat  
− Diperoleh rmsd_ido.xvg 
− Dibuka rmsd_ido.xvg pada Grace 

 
 

d. RMSF 
 

 
− Dibuka analysis.xtc dan md.tpr pada gromacs 
− Dianalisis RMSF menggunakan rmsf 
− Diperoleh rmsf.xvg 
− Dibuka rmsf.xvg pada Grace 

 
 
  

analysis.xtc dan md.tpr 

Hasil 

analysis.xtc dan md.tpr 

Hasil 
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Lampiran 3. Hasil Running Redocking 

Rank Sub-Rank Run Binding 
Energy 

Cluster 
RMSD 

Reference 
RMSD Grep Pattern 

1 1 4 -34.22 0.00 1.06 RANKING 
1 2 151 -34.06 0.50 1.03 RANKING 
1 3 64 -33.94 0.45 1.04 RANKING 
1 4 44 -33.92 0.52 1.05 RANKING 
1 5 2 -33.87 0.85 1.09 RANKING 
1 6 185 -33.77 0.40 1.08 RANKING 
1 7 14 -33.71 0.34 1.06 RANKING 
1 8 65 -33.69 0.56 1.01 RANKING 
1 9 93 -33.64 0.62 1.07 RANKING 
1 10 23 -33.56 0.43 1.09 RANKING 
1 11 141 -33.50 0.48 1.02 RANKING 
1 12 66 -33.49 0.67 0.98 RANKING 
1 13 143 -33.44 0.58 1.00 RANKING 
1 14 27 -33.43 0.51 1.05 RANKING 
1 15 6 -33.42 0.59 1.03 RANKING 
1 16 161 -33.39 0.51 1.01 RANKING 
1 17 111 -33.38 0.54 1.00 RANKING 
1 18 85 -33.31 0.40 1.09 RANKING 
1 19 172 -33.29 0.42 1.05 RANKING 
1 20 176 -33.29 0.64 1.08 RANKING 
1 21 55 -33.26 0.41 1.08 RANKING 
1 22 40 -33.26 0.59 1.05 RANKING 
1 23 94 -33.25 0.67 1.09 RANKING 
1 24 54 -33.24 0.52 1.09 RANKING 
1 25 188 -33.24 0.51 1.06 RANKING 
1 26 187 -33.24 0.55 1.13 RANKING 
1 27 189 -33.23 0.57 0.93 RANKING 
1 28 18 -33.21 0.64 1.10 RANKING 
1 29 142 -33.20 0.56 1.01 RANKING 
1 30 34 -33.19 0.65 0.98 RANKING 
1 31 150 -33.16 0.46 1.01 RANKING 
1 32 121 -33.13 0.42 1.06 RANKING 
1 33 43 -33.12 0.32 1.08 RANKING 
1 34 105 -33.09 0.54 1.00 RANKING 
1 35 46 -33.06 0.51 1.02 RANKING 
1 36 170 -33.02 0.50 0.93 RANKING 
1 37 197 -33.00 0.52 0.93 RANKING 
1 38 82 -32.99 0.51 1.09 RANKING 
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1 39 131 -32.96 0.52 1.00 RANKING 
1 40 195 -32.96 0.59 1.01 RANKING 
1 41 72 -32.95 0.54 1.07 RANKING 
1 42 159 -32.91 0.47 1.07 RANKING 
1 43 114 -32.89 0.65 1.07 RANKING 
1 44 86 -32.88 0.64 0.95 RANKING 
1 45 168 -32.85 0.51 1.00 RANKING 
1 46 52 -32.83 0.56 1.06 RANKING 
1 47 122 -32.80 0.67 1.05 RANKING 
1 48 78 -32.78 0.57 1.00 RANKING 
1 49 104 -32.78 0.82 1.11 RANKING 
1 50 174 -32.71 0.72 1.21 RANKING 
1 51 120 -32.70 0.54 0.99 RANKING 
1 52 91 -32.68 0.72 1.09 RANKING 
1 53 157 -32.63 0.59 0.93 RANKING 
1 54 113 -32.62 0.57 1.10 RANKING 
1 55 84 -32.52 0.47 1.07 RANKING 
1 56 96 -32.50 0.76 1.06 RANKING 
1 57 135 -32.50 0.76 1.21 RANKING 
1 58 163 -32.49 0.55 0.95 RANKING 
1 59 148 -32.48 0.57 0.91 RANKING 
1 60 164 -32.48 0.74 0.94 RANKING 
1 61 11 -32.47 0.71 0.97 RANKING 
1 62 193 -32.46 0.43 1.06 RANKING 
1 63 29 -32.43 0.55 0.99 RANKING 
1 64 173 -32.41 0.60 0.99 RANKING 
1 65 154 -32.38 0.58 1.02 RANKING 
1 66 199 -32.36 0.58 1.03 RANKING 
1 67 128 -32.36 0.55 0.93 RANKING 
1 68 191 -32.34 0.65 1.14 RANKING 
1 69 81 -32.32 0.56 1.06 RANKING 
1 70 196 -32.31 0.46 1.04 RANKING 
1 71 137 -32.29 0.63 1.01 RANKING 
1 72 146 -32.17 0.71 0.89 RANKING 
1 73 171 -32.14 0.60 1.03 RANKING 
1 74 183 -32.14 0.64 0.96 RANKING 
1 75 100 -32.09 0.67 0.91 RANKING 
1 76 130 -32.07 1.06 1.30 RANKING 
1 77 70 -32.07 0.47 1.07 RANKING 
1 78 74 -32.05 0.61 0.95 RANKING 
1 79 166 -32.00 0.62 1.05 RANKING 
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1 80 53 -31.98 0.58 1.00 RANKING 
1 81 41 -31.96 0.79 1.01 RANKING 
1 82 68 -31.94 0.57 1.03 RANKING 
1 83 149 -31.93 0.64 0.89 RANKING 
1 84 92 -31.93 0.91 1.06 RANKING 
1 85 63 -31.90 0.75 1.10 RANKING 
1 86 178 -31.86 0.80 1.11 RANKING 
1 87 106 -31.84 0.76 1.06 RANKING 
1 88 145 -31.77 0.76 0.88 RANKING 
1 89 129 -31.75 0.78 0.98 RANKING 
1 90 39 -31.72 0.68 1.07 RANKING 
1 91 118 -31.71 0.47 0.94 RANKING 
1 92 138 -31.71 0.58 1.06 RANKING 
1 93 71 -31.70 0.59 0.92 RANKING 
1 94 181 -31.69 0.58 1.02 RANKING 
1 95 59 -31.62 0.60 0.83 RANKING 
1 96 48 -31.61 1.10 1.33 RANKING 
1 97 117 -31.53 1.01 1.11 RANKING 
1 98 160 -31.47 0.96 0.96 RANKING 
1 99 5 -31.47 0.61 0.93 RANKING 
1 100 56 -31.45 0.64 1.05 RANKING 
1 101 180 -31.44 0.58 0.97 RANKING 
1 102 32 -31.42 0.68 1.12 RANKING 
1 103 49 -31.42 0.66 1.24 RANKING 
1 104 25 -31.42 0.72 1.14 RANKING 
1 105 194 -31.41 1.23 1.36 RANKING 
1 106 38 -31.36 0.80 0.97 RANKING 
1 107 24 -31.34 0.68 1.05 RANKING 
1 108 124 -31.34 0.70 0.82 RANKING 
1 109 144 -31.28 0.63 1.04 RANKING 
1 110 17 -31.25 0.65 1.04 RANKING 
1 111 101 -31.22 0.82 0.96 RANKING 
1 112 186 -31.22 1.08 1.11 RANKING 
1 113 192 -31.21 0.61 0.96 RANKING 
1 114 33 -31.17 0.47 1.03 RANKING 
1 115 67 -31.16 0.65 0.96 RANKING 
1 116 107 -31.11 0.63 1.13 RANKING 
1 117 95 -31.05 0.65 1.10 RANKING 
1 118 99 -31.04 0.55 0.99 RANKING 
1 119 89 -31.02 0.84 1.18 RANKING 
1 120 73 -31.00 1.00 0.90 RANKING 
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1 121 45 -31.00 0.68 1.19 RANKING 
1 122 158 -30.96 0.79 1.10 RANKING 
1 123 58 -30.89 0.93 1.25 RANKING 
1 124 19 -30.85 1.03 1.05 RANKING 
1 125 152 -30.77 0.89 0.93 RANKING 
1 126 126 -30.76 0.68 1.05 RANKING 
1 127 134 -30.73 0.76 1.06 RANKING 
1 128 57 -30.72 1.15 1.15 RANKING 
1 129 30 -30.65 0.92 1.08 RANKING 
1 130 97 -30.63 0.61 0.93 RANKING 
1 131 35 -30.59 0.62 0.91 RANKING 
1 132 79 -30.56 0.93 1.04 RANKING 
1 133 162 -30.56 0.85 0.91 RANKING 
1 134 77 -30.55 1.10 1.30 RANKING 
1 135 167 -30.48 0.76 1.02 RANKING 
1 136 119 -30.45 1.04 1.21 RANKING 
1 137 102 -30.44 1.41 1.38 RANKING 
1 138 21 -30.35 1.01 1.22 RANKING 
1 139 165 -30.24 1.48 1.37 RANKING 
1 140 115 -30.23 1.32 1.27 RANKING 
1 141 110 -30.22 0.88 1.14 RANKING 
1 142 116 -30.19 1.30 1.26 RANKING 
1 143 8 -30.10 1.36 1.32 RANKING 
1 144 123 -30.07 1.70 1.52 RANKING 
1 145 200 -30.06 1.76 1.82 RANKING 
1 146 136 -30.02 1.35 1.31 RANKING 
1 147 3 -30.01 1.75 1.53 RANKING 
1 148 75 -30.00 1.29 1.28 RANKING 
1 149 87 -30.00 0.91 0.96 RANKING 
1 150 175 -29.99 0.72 1.11 RANKING 
1 151 60 -29.98 0.88 1.13 RANKING 
1 152 90 -29.91 0.73 1.10 RANKING 
1 153 103 -29.84 1.58 1.47 RANKING 
1 154 9 -29.83 0.79 0.95 RANKING 
1 155 140 -29.74 1.35 1.25 RANKING 
1 156 88 -29.56 1.29 1.26 RANKING 
1 157 12 -29.53 1.36 1.23 RANKING 
1 158 26 -29.38 1.03 1.10 RANKING 
1 159 153 -29.37 1.10 1.12 RANKING 
1 160 177 -29.34 1.06 1.06 RANKING 
1 161 31 -29.31 0.97 1.04 RANKING 
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1 162 98 -29.12 1.10 1.12 RANKING 
1 163 112 -29.00 1.68 1.51 RANKING 
1 164 50 -28.95 1.92 1.74 RANKING 
1 165 147 -28.76 1.48 1.28 RANKING 
1 166 61 -28.48 1.66 1.43 RANKING 
1 167 51 -27.49 1.72 1.47 RANKING 
1 168 47 -26.23 1.79 1.64 RANKING 
2 1 16 -28.71 0.00 2.37 RANKING 
2 2 190 -28.69 1.74 1.97 RANKING 
2 3 37 -28.15 1.92 2.28 RANKING 
2 4 15 -27.77 1.88 2.49 RANKING 
3 1 62 -27.99 0.00 3.14 RANKING 
3 2 125 -27.64 0.40 3.08 RANKING 
3 3 127 -27.63 1.00 3.47 RANKING 
3 4 76 -27.49 0.49 3.07 RANKING 
3 5 80 -27.46 1.59 3.20 RANKING 
3 6 10 -27.39 0.72 3.18 RANKING 
3 7 22 -27.07 0.95 3.55 RANKING 
3 8 139 -26.96 1.09 3.26 RANKING 
3 9 36 -26.95 1.94 1.98 RANKING 
3 10 133 -26.50 0.92 2.90 RANKING 
3 11 169 -26.42 1.94 3.03 RANKING 
3 12 184 -26.17 1.31 3.23 RANKING 
3 13 20 -25.85 1.63 2.94 RANKING 
3 14 42 -25.84 1.75 2.76 RANKING 
3 15 155 -25.66 1.60 3.05 RANKING 
3 16 109 -25.61 1.60 2.79 RANKING 
3 17 1 -24.11 1.26 3.57 RANKING 
3 18 156 -23.51 1.62 2.79 RANKING 
4 1 83 -27.49 0.00 2.09 RANKING 
5 1 132 -24.68 0.00 4.91 RANKING 
5 2 179 -24.10 1.52 4.67 RANKING 
5 3 28 -23.87 0.97 4.83 RANKING 
5 4 198 -23.59 1.39 4.76 RANKING 
6 1 7 -22.57 0.00 2.96 RANKING 
7 1 108 -20.89 0.00 4.10 RANKING 
7 2 69 -20.45 1.00 3.89 RANKING 
8 1 182 -17.57 0.00 5.08 RANKING 
9 1 13 -15.23 0.00 4.12 RANKING 
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Lampiran 4. Interaksi Hasil Docking 

No Ligan Natif Ligan 8 mer 2s Ligan 12 mer 2s 

1 A:ALA136:N - E:SGN5:O2S 
(H) 

A:ARG120:HH11 - 
E:IDS6:O5 (H) 

A:ARG120:HE - 
E:IDS12:O6A (H) 

2 A:ARG120:CD - E:IDS4:O3S 
(H) 

A:ARG120:HH12 - 
E:IDS6:O1S (H) 

A:ARG120:HE - 
E:SGN5:O6 (H) 

3 A:ARG120:N - E:IDS4:O3S 
(H) 

A:ARG120:HH12 - 
E:IDS6:O2 (H) 

A:ARG120:HH11 - 
E:IDS10:O6A (H,E) 

4 A:ARG120:NE - E:IDS4:O2 
(H) 

A:ARG120:HH21 - 
E:IDS6:O5 (H) 

A:ARG120:HH22 - 
E:SGN5:O6 (H) 

5 A:ARG120:NH1 - E:IDS6:O3 
(H) 

A:ARG120:HH21 - 
E:IDS6:O6A (H,E) 

A:ARG120:NH2 - 
E:IDS12:O6A 

6 A:ARG120:NH1 - E:IDS6:O3S 
(E) 

A:ARG120:NH1 - 
E:IDS6:O2S (E) 

A:LYS119:NZ - 
E:IDS4:O6A 

7 A:ARG120:NH1 - E:SGN5:O4 
(H) 

A:ARG120:NH2 - 
E:IDS4:O6A (E) 

A:LYS125:HZ1 - 
E:IDS6:O2S (H,E) 

8 A:ARG120:NH2 - E:IDS4:O5 
(H) 

A:ASN27:OD1 - 
E:SGN5:H02 (H) 

A:LYS129:HZ2 - 
E:IDS4:O6A (H,E) 

9 A:ARG120:NH2 - 
E:IDS4:O6A (E) 

A:GLN134:HE21 - 
E:IDS4:O2S (H) 

A:LYS135:CE - 
E:IDS8:O2S (H) 

10 A:ASN27:ND2 - E:IDS4:O3S 
(H) 

A:GLN134:OE1 - 
E:SGN3:H11 (H) 

A:LYS135:HN - 
E:IDS6:O3S (H) 

11 A:ASN27:OD1 - E:SGN5:O3 
(H) 

A:LYS125:HZ2 - 
E:IDS4:O2S (H,E) 

A:LYS135:HZ2 - 
E:IDS8:O3S (H) 

12 A:LYS119:NZ - E:SGN3:O6S 
(E) 

A:LYS129:HZ3 - 
E:IDS2:O1S (H) 

A:LYS135:NZ - 
E:IDS8:O2S 

13 A:LYS125:CE - E:IDS4:O2S 
(H) 

A:LYS129:NZ - 
E:IDS2:O2S (E) 

C:GLU159:OE2 - 
E:SGN11:H02 (H) 

14 A:LYS125:NZ - E:IDS4:O1S 
(H) 

A:LYS135:HN - 
E:IDS4:O3S (H) 

C:GLU159:OE2 - 
E:SGN11:H03 (H) 

15 A:LYS125:NZ - E:IDS4:O2S 
(E) 

A:LYS135:NZ - 
E:IDS6:O2S (E) 

C:GLU159:OE2 - 
E:SGN11:H05 (H) 

16 A:LYS125:NZ - E:SGN5:O1S 
(H,E) 

C:LYS163:NZ - 
E:IDS6:O2S (E) 

D:ARG209:HH12 - 
E:IDS10:O2S (H,E) 

17 A:LYS125:NZ - E:SGN5:O2S 
(H) 

C:LYS177:HZ2 - 
E:IDS8:O3 (H) 

 

18 A:LYS129:NZ - E:IDU2:O6 
(E) 

C:LYS177:NZ - 
E:IDS8:O6A (E) 

 

19 A:LYS129:NZ - E:SGN3:O4S 
(H) 

D:ARG209:HH11 - 
E:IDS8:O3S (H) 

 

20 A:LYS129:NZ - E:SGN3:O6S 
(E) 

D:ARG209:NH1 - 
E:IDS8:O2S (E) 

 

21 A:LYS135:N - E:SGN5:O3S 
(H) 

D:LYS207:HZ3 - 
E:IDS6:O3 (H) 

 

22 A:LYS135:NZ - E:IDS6:O6B 
(H,E) 

D:LYS207:HZ3 - 
E:IDS8:O2 (H) 

 

23 A:LYS26:NZ - E:IDS6:O6B 
(E) 

D:LYS207:NZ - 
E:IDS6:O2S (E) 

 

24 C:HIS166 - E:SGN7:S2 (pi-S) D:LYS207:NZ - 
E:IDS8:O2S (E) 

 

25 C:HIS166:CE1 - E:SGN7:O6S 
(H) 

D:LYS207:NZ - 
E:IDS8:O6A (E) 

 

26 C:LYS160:NZ - E:SGN7:O3S 
(E) 

  



55 
 

 
 

27 C:LYS163:CE - E:SGN7:O5S 
(H) 

  

28 C:LYS163:NZ - E:SGN7:O6S 
(E) 

  

29 C:LYS172:NZ - E:UAP8:O3S 
(E) 

  

30 C:LYS175:NZ - E:UAP8:O6A 
(H) 

  

31 C:LYS175:NZ - E:UAP8:O6B 
(E) 

  

32 C:LYS177:NZ - E:SGN7:O2S 
(H) 

  

33 C:LYS177:NZ - E:SGN7:O3 
(H) 

  

34 C:LYS177:NZ - E:SGN7:O3S 
(E) 

  

35 C:LYS177:NZ - E:UAP8:O6A 
(H) 

  

36 C:LYS177:NZ - E:UAP8:O6B 
(E) 

  

37 D:LYS207:CE - E:UAP8:O3 
(H) 

  

38 D:LYS207:NZ - E:IDS6:O6B 
(E) 

  

39 D:LYS207:NZ - E:SGN5:O5S 
(E) 

  

40 D:THR173:OG1 - 
E:UAP8:O2S (H) 

  

 

  



56 
 

 
 

Lampiran 5. Visualisasi Konformasi Asam Iduronat  

L.5.1 Visualisasi konformasi ligan natif hasil simulasi 
Waktu Visualisasi ligan 

0 ns 

 

50 ns 

 

100 ns 

 
 
L.5.2 Visualisasi ligan 8 mer 2S hasil simulasi 

Waktu Visualisasi ligan 

0 ns 

 

50 ns 
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100 ns 

 
 
L.5.3 Visualisasi ligan 12 mer 2S hasil simulasi 

Waktu Visualisasi ligan 

0 ns 

 

50 ns 

 

100 ns 
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